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1 Welcome 

The Telescience Resource Kit (TReK) is a suite of software applications and libraries that 

can be used to monitor and control assets in space or on the ground.   

 

The TReK Command application provides the capability to update, send, and track 

commands to various command destinations.  It can execute sequences of commands 

from pre-compiled binaries as well as providing the capability to receive commands from 

other systems for forwarding.   

 

1.1 Getting Started 

The Introduction section provides an application overview.  The Quick Start Guides 

section has “How Tos” for common tasks.  The Details section will elaborate more fully 

on topics and the FAQ and Troubleshooting section has helpful hints and solutions to the 

common “gotchas”. 

 

2 Technical Support 

If you are having trouble installing the TReK software or using any of the TReK 

software, please contact us for technical assistance: 

 

E-Mail:            trek.help@nasa.gov 

 

Messages sent to this address are automatically forwarded to the TReK team. 

 

The HOSC Help Desk (256-544-5066) can provide assistance as needed and is available 

24x7. 

3 Introduction 

The TReK Command application provides the capability to update, send, and track 

commands to various command destinations.  It can execute sequences of commands 

from pre-compiled binaries as well as providing the capability to receive commands from 

other systems for forwarding. 

 

4 Overview of the User Interface 

4.1 Main Window 

The main window, shown in Figure 1, shows the Commands / Command Sequences, 

Command Track, Command Sequence Transactions, and Message Area.  Command 

Track, Command Sequence Transactions, and Message Area are docking components: 

 

• To float a dock, use your left mouse button to click and hold the titled top area 

while dragging the component to another area of the screen.  
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• To dock, use the titled top area to drag the dock window over the main window.  

The application will provide feedback of where the final placement will occur 

when released. 

• To remove a dock component, click the “x” button in the top right corner of the 

dock component. 

• To restore a removed dock component, use the View menu option to restore the 

component. 

 

 

Figure 1 Main Window 

Toolbar 

The toolbar at the top of the window provides quick access to configure the application 

and start and stop the command service. 

  

POIC Command Status and Configuration Toolbar 

The POIC Command Status and Configuration toolbar (located under the Configuration 

toolbar) provides quick access to POIC Command Status and Configuration information.  

This toolbar is only available when a POIC destination is active. 
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Commands / Command Sequences 

The Commands / Command Sequences area has two tabs.  When activated, the 

Commands tab can be used to update or send individual commands. The Command 

Sequences tab can be used to start sending commands in a sequence from a pre-compiled 

command sequence binary file. 

 

Command Track 

The Command Track area displays the history of commands sent.   

 

Command Sequence Transactions 

The Command Sequence Transactions area displays a list of command sequences and 

their current execution status.  It will also display a convenience button to stop the 

execution of the selected sequence if active.  It can be cleared from the Command Menu. 

 

Message Area 

The Message Area displays important status and error message.  It can be cleared from 

the View Menu. 

 

4.2 Toolbar 

The toolbar provides visual information about the state of the application and provides 

access to common application functions.   

 

Configuration Status 

When the Configuration status is black, this indicates the application has not been 

configured.  When the Configuration status is green, this indicates the application has 

been configured and the command service can be activated.   

 

Use the Configure button to configure the application using the Configure dialog. 

 

Operational Status 

When the Operational status is black, the command service is inactive.  When the 

Operational status is green, the command service is active and sending a command or 

executing command sequence can begin.  The application must be properly configured 

before the Activate button will be available.  The command service must be active before 

the Deactivate button will be available. 

 

Use the Activate button to activate the command service.  This will initiate activities 

needed to support commanding tasks.  When you activate the command service, you will 

see activation status messages in the main window message area.   If you need to 

reconfigure the command application, deactivate the command service, and then push the 

Configure button to reconfigure. 
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4.2.1 POIC Command Status and Configuration Toolbar 

The POIC Command Status and Configuration toolbar is shown in Figure 2.  This 

Toolbar will only be available when the Command service is Active and the Destination 

Type is POIC. 

 

 

 

Figure 2 POIC Command Status and Configuration Toolbar 

4.3 Menus 

The Command application menus are File, View, Command, Options, and Help.  Each of 

these menus is described in more detail below. 

 

File Menu 

The File menu provides the capability to manage configurations and exit the application.   

 

View Menu 

The View menu provides the capability to clear the main window message area and show 

and hide different areas in the main window.   

 

Command Menu 

The Command menu provides the capability to configure the application, activate and 

deactivate the command service.  It also provides access to functions such as updating a 

command, sending a command, viewing command communication messages, and 

viewing command track information.  The Command menu is context sensitive and will 

display additional items based on the Command Destination Type.   

 

As shown in Figure 3, additional menu items are displayed when the Command 

Destination Type is a POIC destination. 
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Figure 3 Command Menu 

 

Options Menu 

The Options menu provides access to the Messages dialog, the Command Preferences 

dialog, Manage Email and Text Settings, and the Advanced Settings dialog.  The 

Messages dialog displays application messages.  The Command Preferences dialog 

provides the capability to configure preferences such as the Command Confirmation 

Prompt.  The Advanced Settings dialog provides access to advanced settings. 

 

Help Menu 

The Help menu provides access to on-line help and application version information. 

 

5 Quick Start Guides 

This section provides “How Tos” for common functions. 

 

5.1 How to Configure the Command Application 

The following steps describe the minimum necessary to configure the application.  For 

additional information and details about the Configure dialog please reference section 

6.1. 

 

1. Push the Configure button to display the Configure dialog. 

2. On the General tab enter the Destination Name and Destination Type.  Fill in the 

Communication Settings. 
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Note:  If the Destination Type is POIC, enter the HOSC Login Name.  If you are 

using the VPN client, enter the Office Mode IP Address returned by the HOSC VPN 

client in the Local IP Address field. 

3. On the Command tab, add commands to the Command list. 

4. On the Command Sequences tab, add command sequences to the Command Sequence 

list. 

5. Optional:  On the History tab, select the Yes radio button to enabled writing 

command history information.  Fill in the Directory.  It will default to the 

command_history directory in the trek_workspace directory. 

6. Leave the Bridge tab with default values. 

7. Push the OK button to save the configuration information and exit the dialog. 

 

If the application is configured correctly, the Configuration status will be green and the 

Activate button will lock-in and being using the set configuration. 

 

5.2 How to Send a Command 

The following steps describe the minimum necessary to send a command once the 

Command service is active.  

 

1. Select a command in the Main Window’s Commands Tab’s Command List. 

2. Push the Send button located under the Command List. 

 

Note:  If the Command Send is successful, you will see the results in the Main Window 

Command Track Area.  If an error occurs, you will see an error message. 

 

5.3 How to Update a Command 

The following steps describe the minimum necessary to update a command once the 

Command service is active. 

 

1. Select a command in the Main Window’s Commands Tab’s Command List. 

2. Push the Update button located under the Command List. 

3. In the Command Update dialog, modify the command as needed. 

4. Push the OK button to save the updates and exit the dialog. 

 

5.4 How to Start a Command Sequence 

The following steps describe the minimum necessary to start executing a command 

sequence once the Command service is active. 

 

1. Select a command sequence in the Main Window’s Command Sequences Tab’s 

Command Sequence list. 

2. Push the Start button located under the Command Sequence list. 
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Note:  If the Command Sequence Start is successful, you will see the commands as they 

are executed in the Main Window Command Track area, and you will see a command 

sequence transaction in the Command Sequence Transactions area.  Each started 

sequence has a unique transaction ID.  If an error occurs, you will see an error message in 

the Message Area. 

 

5.5 How to Stop a Command Sequence 

The following steps describe the minimum necessary to stop an executing a command 

sequence. 

 

1. Select the executing command sequence to stop in the Command Sequence 

Transactions area. 

2. Push the Stop button to request the sequence be stopped. 

 

Note: Only currently executing sequences can be stopped. 

 

5.6 How to Start and Stop the Command Service 

This section describes how to start and stop the Command service.  

 

1. Before the Command service can be started, you must configure the application.  To 

learn more about this see section 5.1.  The configuration status must be green before 

you can start the Command service. 

2. To start the Command service, push the Activate button on the toolbar.  If this is 

successful, the Operational status will turn green.  When the Operational status is 

green you can start commanding. 

3. To stop the Command service, push the Deactivate button. 

4. When activating or deactivating, important status and/or error messages will be 

displayed in the Main Window message area. 

 

6 Details 

This section covers various application details. 

 

6.1 Configuration 

The Configure dialog provides the capability to configure the command service.   Each 

tab is described below.  The Command configuration can only be modified when the 

Command service is inactive. 

 

6.1.1 General Tab 

The General tab is shown in Figure 4.  Each field is described below. 
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Figure 4 Command Configuration Dialog (General Tab) 

 

 

Destination Name 

This field should contain a user-defined name for the destination. 

 

Destination Type 

The Command application provides the capability to communicate with different types of 

command destinations.  The Destination Type identifies the type of Destination.  The 

UFO destination is an “Unidentified Destination” meaning the TReK software has no 

knowledge about the destination.  Therefore, you must set the Communication Type to 

the correct setting based on the interface supported by the destination.  All versions of 
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TReK will contain a UFO destination.  Additional destination types may be available as 

applicable to individual projects. 

 

The POIC Destination Type requires a specific communication type which will 

automatically be configured when POIC is selected.  You will also need to fill in 

information on the HOSC Login Name.   

Additional destination types for the ISS program include PRCU, RAPTR, and SCS.  

These all require a specific communication type which will be automatically configured 

when you select one of these destinations. 

HOSC Login Name 

This field is only required for a POIC Destination.  It should contain the name of an 

active HOSC Login Session that was created using the TReK HOSC Login application.  

The Browse button can be used to view and select a HOSC Login Name. 

 

Communication Settings Area 

The Communication Settings area changes depending on the Communication Type 

setting.  If a Destination Type has a required Communication Type, it is automatically 

selected.  The UFO Destination Type can have any Communication Type and is used to 

describe the different options for Communication Type:  TCP Listener as shown in 

Figure 5, TCP Client as shown in Figure 6, and UDP as shown in Figure 7.    
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Figure 5 TCP Listener Communication Type 
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Figure 6 TCP Client Communication Type 
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Figure 7 UDP Communication Type 

 

On the general tab, these fields define the communication settings: 

 

Local IP Address 

A socket is created to send and receive command information.  This is the local IP 

address used for the socket. 
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Local Port 

A socket is created to send and receive command information.  This is the local port used 

for the socket.  If the communication type is TCP Client or UDP, you can use 0 for the 

port and an available port will be selected for you. 

 

Destination Information (when using a TCP Client) 

Destination information fields include the Destination Host Name, Destination IP 

Address, and Destination Port.     

 

Note:  If you are connecting to the Destination, enter the Destination Host Name or IP 

Address and the Destination Port.  If you are connecting to a TReK training tool that is 

simulating the Destination, enter the IP Address and Port corresponding to the 

configuration of the training tool.  For example, if you are running the training tool on the 

same computer as the TReK Command application, then you would use your local IP 

address for the Local IP Address and the Destination IP Address.  

 

Firewall Information 

If your computer is behind a firewall, and you need support for Network Address 

Translation, you can enter the information on the Firewall tab.  The Firewall tab is shown 

in Figure 8.   
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Figure 8 Command Communication General Tab Firewall Information 

 

Each field is described below. 

 

Firewall In Use (Network Address Translation Needed) 

Check the “Firewall In Use” checkbox if your location is using a Firewall with network 

address translation. 
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Firewall IP Address 

The Firewall IP Address. 

 

Firewall Command Port 

The Port on the Firewall that should be used for network traffic. 

 

6.1.2 Commands Tab 

The Commands tab is shown in Figure 9.  The Commands tab is used to identify a set of 

commands that can be sent to the destination. 

 

 

Figure 9 Command Configuration (Commands Tab) 

 

Each field and button is described below. 

 

Command 

The Command list is used to identify the set of commands that can be sent to the 

destination.   

 

Browse Database 

The Browse Database button is used to browse and select commands from a TReK 

Command Database. 
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Browse Disk 

The Browse Disk button is used to browse and select a command defined in a TReK 

metadata file (Packet file). 

 

Delete 

The Delete button is used to delete a command from the list. 

 

6.1.3 Command Sequences Tab 

The Command Sequences tab is shown in Figure 10.  This tab identifies the command 

sequences that can be executed for the destination. 

 

 

Figure 10 Command Configuration (Command Sequences Tab) 

Each field and button are described below. 

 

Command Sequence 

The Command Sequence list is used to identify the set of command sequences that can be 

started when active.   

 

Browse Disk 

The Browse Disk button is used to browse and select the binary command sequences files 

available. 

 

Delete 

The Delete button is used to delete a command sequence from the list. 
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6.1.4 History Tab 

The History tab is shown in Figure 11.  The History tab is used to enable the Command 

History capability.  Enabling the Command History capability will record information 

about each command sent including the name of the command, the content of the 

command, and the time the command was sent.   

 

 

Figure 11 Command Configuration (History Tab) 
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Each field is described below. 

 

Command History 

The No and Yes radio buttons disable or enable the Command History capability. 

 

Directory 

The Directory is used to identify the directory where the command history information 

should be recorded.  This will default to the trek_workspace command_history directory. 

 

6.1.5 Bridge Tab 

The Bridge tab is shown in Figure 12.  When enabled, the Command Bridge capability 

provides a way to define a socket to receive an incoming command and redirect it to the 

Destination you configured on the General tab.  This provides a way to configure this 

application as a “central hub” for commanding activities. 
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Figure 12 Command Configuration (Bridge Tab) 

 

Each field is described below. 

 

Bridge 

The No and Yes radio buttons disable or enable the Bridge capability. 
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Default Command Name 

The Default Command Name is used to identify the default name that will be used when 

the command is sent to the destination.  The default command name does not have to be 

added on the Commands tab. 

 

Command Mapping 

The Command Mapping checkbox is used to enable command mapping.  Command 

mapping is optional.   

 

Command Mapping File 

The Command Mapping File field is used to identify the absolute path to a command 

mapping file.  A command mapping file is used to describe mapping of incoming data to 

different command names based on an identifier value in the data.  It is a text file with 

keywords and required fields as described below (all keywords except BYTE_ORDER 

are required): 

 

➢ ID_START start_bit 

• start_bit – The offset from the beginning of the incoming data packet to the 

field for the identifier. 

 

➢ ID_LENGTH length 

• length – The length of the identifier in bits.  Note:  All identifiers are unsigned 

integers.  Lengths can be up to 64 bits.  

 

➢ BYTE_ORDER order 

• order – The byte order of the identifier as a string.  Valid values are 

big_endian, little_endian, byte_swapped, and word_swapped.  Default if not 

supplied is big_endian. 

 

➢ COMMAND value name 

• value – The unsigned integer value corresponding to the command. 

• name – The name of the command to use when sending.  Note:  No length 

restrictions are placed on the command, but some destinations may have 

restrictions.  The command names do not have to be added on the Commands 

tab. 

 

Example File (# is used for comments): 

 
# Example Command Mapping File 

ID_START       176 

ID_LENGTH      16 

COMMAND        0         NoOp1 

COMMAND        1280      NoOp2 

COMMAND        39320     ArmExit 
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Communication Settings Area 

The Communication Settings area is used to define the type of socket to use for the 

bridge.  The following communication types are available:  UDP, TCP Listener, and 

TCP Client.   

 

General tab: 

 

Local IP Address 

A socket is created to receive the incoming command.  This is the local IP address used 

for the socket. 

 

Local Port 

A socket is created to receive the incoming command.  This is the local port used for the 

socket. 

 

Destination Information (when using TCP Client) 

Destination information fields, as shown in Figure 13  include the Destination Host 

Name, Destination IP Address, and Destination Port.    

 

 

Figure 13 Bridge Communication Destination Information 

 

Queue Tab: 

 

Queue Information 

The Queues tab is shown in Figure 14.  Each field is described below.  Setting a queue 

can help with high rate commanding to prevent loss of data. 
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Figure 14 Bridge Communication Queues Information 

 

Receive Queue Size 

The number of commands to queue. 

 

Receive Buffer Size (bytes) 

The number of bytes to allocate for each command in the queue.  Should be at least as 

large as the maximum allowed command size. 

 

Firewall tab: 

 

Firewall Information 

The Firewall tab is shown in Figure 15.  Each field is described below. 

 

 

Figure 15 Bridge Communication Firewall Information 

 

Firewall In Use (Network Address Translation Needed) 

Check the “Firewall In Use” checkbox if your location is using a Firewall with network 

address translation. 

 

Firewall IP Address 

The Firewall IP Address. 

 

Firewall Command Port 

The Port on the Firewall that should be used for network traffic. 
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6.2 Command Tab 

The Command Tab is shown in Figure 16.   

 

 

Figure 16 Command Area Populated with Commands 

 

When the Command service is activated, any commands defined in the Command 

Configuration are added to the Commands tab in the Main Window.  Any command 

sequences defined in the Command Configuration are added to the Command Sequences 

tab.  Applicable Command buttons are also displayed.  The Command buttons will be 

disabled until a command is selected.  The Command buttons are described below: 

 

Update 

The Update button is used to update the contents of a local command.   The Update 

Command dialog, shown in Figure 17, will be populated with information about the 

command selected using the metadata identified when the command service was 

configured (TReK metadata file or a local TReK command database) and the contents 
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from the last command update performed.  The Update Command dialog is used to 

modify the contents of modifiable command fields only.   

 

 

Figure 17 Update Command Dialog 

 

Note: These command parameter updates are not saved back to the command metadata 

nor to the configuration saved settings. 

 

Update POIC 

The Update POIC button is only available when the destination type is POIC.  When you 

push the Update POIC button, TReK submits a request to the POIC to update the contents 

of the command in the POIC database with the contents of the command data stored 

locally (the last update you made to the command contents). 

 

Initiate 

The Initiate option is only available for a command that is associated with a POIC 

destination.  When you push the Initiate button, a request is sent to the POIC to build the 

command using the command data stored in the POIC database and then uplink the 

command.  TReK only sends the command name to the POIC since the POIC will get all 

the information on how to build the command from the POIC database. 

 

Note:  The POIC calls this type of command request a remotely initiated command 

request.  
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Send 

The Send button is used to send a command.  TReK uses the command data stored 

locally (the last update you made to the command contents) to build the command uplink 

pattern and then send the uplink pattern to the destination. 

Note:  In the case of a POIC destination, the POIC calls this type of command request a 

remotely generated command request.  

6.3 Command Sequences Tab 

The Command Sequences Tab is shown in Figure 18. 

  

 

Figure 18 Command Sequences Tab 

When the Command service is activated, any command sequences defined in the 

Command Configuration are added to the Command Sequences tab in the Main Window.  

The Command Sequences buttons are described below: 

 

Start 

The Start button is used to start the process of sending commands from the selected pre-

compiled command sequence binary file. 

 

6.4 Command Sequence Transactions Area 

The Command Sequence Transactions area is shown in Figure 19. 

 

 

Figure 19 Command Sequence Transactions area 

 

When a command sequence is started, a new transaction is created and displayed in the 

area illustrated above.  Each transaction is given a unique identifier for tracking and 

control purposes.  The following columns are displayed: 

 



5.4.0 ISS  TREK-USER-0014 

 26 

ID 

The ID column displays the unique transaction identifier assigned to the command 

sequence on start. 

 

Name 

The Name column is the name of the command sequence being executed. 

 

Status 

The Status column is the status of the command sequence. 

 

Command # 

The Command # column displays the ordinal number of the command within the 

command sequence that has executed thus far. 

 

Time Start 

The Time Start column displays the time the command sequence started to execute. 

 

Time End 

The Time End column displays the time the command sequence concluded execution. 

 

Stop 

The Stop button allows the user to attempt to stop execution of a command sequence if it 

is still executing.   Select the transaction row in the Command Sequence Transactions to 

activate the Stop button. 

 

6.5 Command Track Area 

The Command Track Area is shown in Figure 20.   

 

 

Figure 20 Command Track Area 

 

When the Command service is activated, any commands sent are listed in the Command 

Track Area in the Main Window.  The Command Track Area columns are described 

below.   

 

Command 

The Command column displays the name of the command sent. 

 

Uplink Time 

The Uplink Time column displays the time the command was sent. 
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Command Response Columns 

Command Response columns will be displayed if the Destination supports command 

responses.  Note:  UFO destinations do not have command responses. 

 

{else} 

Command Response Columns 

Command Response columns will be displayed if the Destination supports command 

responses. 

 

Double clicking on a command track item that does not have command responses will 

yield the dialog shown in Figure 21 since there are no response details available. 

 

 

Figure 21 Response Details Message 

 

For a POIC Destination the command response columns are ERR, CAR1, CAR2, FSV1, 

FSV2, and CRR.  The Command Track for a POIC Destination is shown in Figure 22. 

 

 

Figure 22 Command Track Area Configured for a UFO Destination 

 

Command responses are color coded to indicate success (green) or failure (red).  It is 

possible to retrieve additional information about a command response by double clicking 

on the item in the Command Track list.  This will display a dialog like the one shown in 

Figure 23. 
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Figure 23 Command Response Details 

 

Command Track Dialog 

The Command Track dialog is shown in Figure 24.  The Command Track dialog displays 

the same information that is displayed in the Main Window Command Track area.   

 

 

 

Figure 24 Command Track Dialog 

 

Clear 

The Clear button will clear all command track information in all views (Command Track 

in the Main Window and the Command Track dialog). 

 

6.6 Command Communication Messages Dialog 

The Command Communication Messages dialog is shown in Figure 25.  It is accessed 

from the main window’s Command menu “View Command Communication Messages."  

Information is displayed in a text/hexadecimal format. 
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Figure 25 Command Communication Messages Dialog 

 

6.7 Command Preferences Dialog 

The Command Preferences dialog is shown in Figure 27.  It is accessed from the main 

window’s Options menu.  This dialog is used to configure command preferences.   The 

Set to Defaults button can be used to reset the properties in this dialog to application 

defaults. 

 



5.4.0 ISS  TREK-USER-0014 

 30 

 

Figure 26 Command Preferences Dialog 

 

Each field is described below. 

 

Send Command Confirmation Prompt 

If the Send Command Confirmation Prompt checkbox is checked, a dialog will be 

displayed asking for confirmation to proceed each time an Initiate or Send action is 

requested. 

 

Start Command Sequence Confirmation Prompt 

If the Start Command Confirmation Prompt checkbox is checked, a dialog will be 

displayed asking for confirmation to proceed each time Start Command Sequence action 

is requested. 

 

Cancel all Command Sequences Confirmation Prompt 

If the Cancel all Command Sequences Confirmation Prompt checkbox is checked, a 

dialog will be displayed asking to confirm cancelling all command sequences if a user 

action will cancel all command sequences such as deactivating the application or exiting. 

 

TReK 3.x API Compatibility 

The TReK 3.x API Compatibility checkbox can be used to set a flag to allow TReK to 

behave the same as TReK 3.x with respect to the AddHeaderAndUplinkCommand() 

function.  In TReK 3.x this function required two extra bytes for the checksum.  TReK 

5.x no longer requires those bytes.  When the checkbox is checked, TReK will remove 

those two extra bytes to mimic the TReK 3.x behavior.  This will also change the TReK 

5.x behavior for the InsertDataAndUplinkCommand method of the CommandApi class.  

It should only be used if you are exclusively using the TReK 3.x compatible API. 

 

Maximum Number of Command Track Items to Display 

This field is used to enter the maximum number of command track items to display.  This 

must be an unsigned integer value.  Once the maximum is reached, older tracked items 
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are deleted to make room for new track items.  The “Log TReK Command Interface 

Messages” capability, available on the Advanced Settings dialog, can be used to log all 

command track information.  To capture all command track information, this capability 

should be turned on prior to activating the command service. 

 

Maximum Number of Command Communication Messages to Display 

This field is used to enter the maximum number of command communication messages 

to display.  This must be an unsigned integer value.  Once the maximum is reached, older 

messages are deleted to make room for new messages.  The “Log TReK Command 

Interface Messages” capability, available on the Advanced Settings dialog, can be used to 

log all command communication messages that are part of the sequence(s) that were sent.  

To capture all messages, this capability should be turned on prior to activating the 

command service. 

 

Maximum Number of Command Sequence Transactions to Display 

This field is used to enter the maximum number of command sequence transactions to 

display.  This must be an unsigned integer value.  Once the maximum is reached, older 

transactions are deleted to make room for new sequences.  The “Log TReK Command 

Interface Messages” capability, available on the Advanced Settings dialog, can be used to 

log all command communication messages.  To capture all messages, this capability 

should be turned on prior to activating the command service. 

 

Pad Non-String Variable Length Command Fields 

If this checkbox is checked, variable length command fields that have a data type of 

“unspecified bytes” will be padded to word boundaries with the pad byte identified in the 

Pad Byte field if needed. 

 

Pad Byte 

This field is used to enter the pad byte to use when padding non-string variable length 

command fields.  This must be a one-byte hexadecimal value.  This field will only accept 

hexadecimal entries. 

 

Terminate String Command Fields 

If this checkbox is checked, string command fields will be terminated with the terminator 

identified in the Terminator field if space is available. 

 

Terminator 

This field is used to enter the terminator to use when terminating string command fields.  

This must be a one-byte hexadecimal value.  This field will only accept hexadecimal 

entries. 

 

 

6.8 Manage E-Mail and Text Settings Dialog 

The Manage E-Mail and Text Settings Dialog is shown in Figure 27.  This dialog is 

accessed from the Options menu.   It provides the capability to manage global e-mail and 
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text settings, application alert settings, e-mail, and text dropboxes, and the capability to 

send an e-mail or text. 

 

 

Figure 27 Manage E-Mail and Text Settings Dialog (Global Settings Account Tab) 

 

The TReK software’s e-mail and text capability is dependent on libcurl, an open-source 

client-side URL transfer library developed by the cURL project. The libcurl library 

provides C API functions that configure the library to programmatically establish a 

secure connection with an email server.  It uses a Transport Layer Security (TLS) version 

1.3 socket prior to logging into an e-mail account using an e-mail account name and 

password. 

 

The TReK e-mail and text capability has been successfully tested with the Google Gmail 

server.  It is recommended that users create a new Gmail account and use it to send e-

mails and texts to designated recipients.  The TReK software does not support retrieving 

emails from the user's Gmail account.  When creating the Gmail account to send e-mails 

and texts, you will need to configure your Gmail account to enable two-step verification, 

and you need to generate a Gmail App Password for TReK.  Please reference Gmail Help 

for instructions.  The Gmail App Password is used in place of your e-mail account 

password on the Global Settings Account tab in the “Manage E-Mail and Text Settings” 

dialog.  TReK recommends only using the Gmail account to send emails and texts using 

the TReK software.  TReK does not recommend using the account to receive e-mails. 

 

The maximum size of a text message is approximately 900 characters.  If you send more 

than 900 characters, your message may be broken up during transmission and then 

concatenated on the recipient’s phone.  The maximum length of a TReK email message is 
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65,000 characters or bytes.  The maximum length of an email with a file attachment is 

generally considered to be 10MB (email message size plus file attachment size).  Note: 

File attachments may become much larger than their original file sizes.  This is due to the 

encoding employed by email servers when sending non-text-based information. 

 

Global Settings 

Global Settings are email and text settings used in all TReK applications.  They can be 

changed in any TReK application with a Manage E-Mail and Text Settings dialog.  When 

you change a setting on the Global Settings tab, it will be changed for all TReK 

applications.  Each Tab is described below. 

 

Allow Alerts 

The Allow Alerts Checkbox is a global setting to turn on and off all alerts in all TReK 

applications.  If you turn this checkbox off, no alerts will be generated in any 

applications. 

 

Export  

The Export button provides access to the Export dialog shown Figure 28.  This dialog 

provides the capability to save the settings on the Global Settings tab in a TReK email 

configuration file that can be used with the TReK E-Mail and Text API.  You also have 

the option to include the dropboxes defined on the E-Mail and Text Dropboxes tab. 

 

 

Figure 28 Manage E-Mail and Text Settings (Export Dialog) 

 

Account 

To use the Alerts capability, you must have a Gmail account.  The Gmail account must be 

configured with two-step verification enabled and you must have a Gmail App Password 

for TReK.  Please reference Gmail Help for instructions.  The Account tab is used to 

enter your Gmail account information.  The TReK software only stores account 

information locally.  The account password will be hidden by default and will always be 

encrypted when it is stored.  Please enter the Gmail App Password you generated for 

TReK in the E-Mail Account Password field (not your Gmail account password).  This 

password will only be decrypted when it is used communicate with the Gmail server to 

execute a requested function.  An example of account information is shown below. 

 

smtp_server_address:  smtp.gmail.com 

email_account_username: jane.doe@gmail.com 
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email_account_password: Gmail App Password for TReK [Hidden unless show 

checkbox is checked] 

email_address:  jane.doe@gmail.com 

email_name:   Jane Doe 

 

The Verify Certificate Authorities checkbox is used to turn on the certificate authority 

check.  If you turn on the certificate authority check, you must provide the complete path 

to a Certificate file. 

 

The Enable Curl Debug Messages checkbox is used to turn on additional debug messages 

generated by the curl software library. 

 

 

E-Mail List 

The E-Mail List tab is used to enter email addresses that will be used to populate the 

email address list that is available when configuring alert functions or sending an email.  

The E-Mail List tab is shown in Figure 29.  The Add button is used to add a row to enter 

email address information.  The Delete button is used to delete a row. 

 

 

Figure 29 Manage E-Mail and Text Settings Dialog (Global Settings E-Mail List Tab) 

 

Cell List 

The Cell List tab is used to enter mobile cell phone numbers that will be used to populate 

the Cell list that is available when configuring alert functions or sending a text.  The Cell 

List tab is shown in Figure 30.  The Add button is used to add a row to enter cell number 

information.  The Delete button is used to delete a row.  Cell numbers can be entered 
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with or without dashes.  The Set Carrier button is available when a Cell Carrier cell is 

selected.  It is shown in Figure 31 and can be used to select a carrier address.  If the 

carrier address you need is not in the list, you can enter it directly into the cell. 

 

Note:  The cell carrier list is populated from a file in the TReK install (config/cell.txt).  If 

you wish to edit the file and make a custom list of carriers to be displayed in the dialog, 

copy the cell.txt file to the root directory of the TReK workspace and make your changes.  

If a cell.txt file exists in the root directory of the TReK workspace, it will be used instead 

of the one available in the install. 

 

 

Figure 30 Manage E-Mail and Text Settings Dialog (Global Settings Cell List Tab) 
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Figure 31 Manage E-Mail and Text Settings (Set Carrier Dialog) 

 

Group List 

When configuring an application alert or sending an email or text, you will have the 

option to identify an email address, a cell phone number, or a group as a recipient.  The 

Group List is shown in Figure 32.  You can define zero or more groups.  A group can 

contain e-mail addresses and cell numbers.  If you have a group with both email 

addresses and cell numbers and you send an e-mail to that group, the email generated will 

only be sent to the e-mail addresses in the group.  You can add, modify, and delete a 

group using the buttons on the right. 

 



5.4.0 ISS  TREK-USER-0014 

 37 

 

Figure 32 Manage E-Mail and Text Settings Dialog (Global Settings Group List Tab) 

 

The Add button will display the Add Group dialog shown in Figure 33.  At the top you 

can enter a name for the group.  On the left you will see all the e-mail addresses and cell 

numbers you entered on the Global Settings main E-Mail List and Cell List tabs.  You 

can add zero or more email addresses and zero or more cell numbers to a group.  To add 

an e-mail or cell to the group, select the e-mail or cell number on the left and push the 

Add button to add it to the group.  You can use the Delete button to delete a recipient 

from the group. 

 

 

Figure 33 Manage E-Mail and Text Settings (Add Group Dialog) 
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Application Alerts 

The Application Alerts tab is shown in Figure 34.  It is used to configure application 

specific alerts.   

 

 

Figure 34 Manage E-Mail and Text Settings Dialog (Application Alerts Tab) 

 

 

 

Enable Application Alerts 

The Enable Application Alerts Checkbox is used to turn all alerts on or off in the current 

application.  If you uncheck Enable Application Alerts, no alerts will be generated in the 

Command application. 

 

Event List 

The Event area provides the capability to identify one or more alerts to send when a 

specific application event occurs.  You can add, modify, and delete alerts using the 

buttons on the right.  The Add button will display the Add Alert dialog shown in Figure 

35.   
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Figure 35 Manage E-Mail and Text Settings (Add Alert Dialog) 

 

Event 

The Event is what triggers the alert.  There may be one or more events in an application 

that can trigger an alert.  The Command application can generate an alert for the 

following types of events: 

 

Lost Connection 

This event is triggered if the command connection is lost. 

 

Type 

The type of alert to send.  Options are E-Mail, E-Mail and Text, or Text. 

 

Recipient 

The recipient identifies who should be notified when the event is triggered.  The 

Recipient list will be populated with applicable recipients based on Type.  If you select E-

Mail in the Type menu, the Recipient list will be populated with e-mails from the E-Mail 

List tab and groups that contain at least one e-mail address from the Group List tab.  If 

you select E-Mail and Text in the Type menu, the Recipient list will be populated with 

groups from the Group List tab that contain at least one e-mail address and one cell phone 

number.  If you select Text in the Type menu, the Recipient list will be populated with 

cell phone numbers from the Cell List tab and groups that contain at least one cell phone 

number from the Group List tab. 

 

Additional Text 

The alert will contain the name of the event that occurred and any text that is provided in 

the Additional Text field.  Additional Text is optional. 

 

 

E-Mail and Text Dropboxes 

The E-Mail and Text Dropboxes tab is shown in Figure 36.  This tab can be used to 

define E-Mail and Text Dropboxes.  It is important to remember that each E-Mail and 

Text Dropbox will correspond to a directory on the file system and must be unique.  

Using a directory for more than one dropbox will result in unexpected behavior.  When 
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you define a dropbox using the Manage E-Mail and Text Settings dialog, the dropbox 

information is automatically saved with that specific application’s settings. 

 

 

Figure 36 Manage E-Mail and Text Settings Dialog (E-Mail and Text Dropboxes Tab) 

 

Dropbox List 

The Dropbox List is used to define zero or more dropboxes.  For each dropbox you can 

define the Dropbox Type, the Dropbox Path, the Dropbox Success Path, a Recipient, and 

a State.  The Add Dropbox dialog is shown in Figure 37. 

 

 

Figure 37 Manage E-Mail and Text Settings (Add Dropbox Dialog) 

 

Dropbox Type 
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There are three types of dropboxes: E-Mail, E-Mail File, and Text.  An E-Mail dropbox 

will e-mail the contents of a text file placed in the dropbox.  An E-Mail File dropbox will 

e-mail the file placed in the dropbox.  A Text dropbox will text the contents of a text file 

placed in the dropbox.  E-Mail and Text dropboxes only support text files.  Dropping 

other file types into these dropboxes will have unexpected results (e.g., send garbage).  

The E-Mail File dropbox supports many common file types including but not limited to 

text files, Portable Document Format (PDF) files, and Microsoft Office files.  It does not 

support executable files.  The E-Mail File dropbox will generate an error or fail to send 

file types that are not supported.  

 

Dropbox Path 

The Dropbox Path identifies the local directory to be used for the dropbox.  The Browse 

button can be used to select a directory.   

 

Dropbox Success Path 

The Dropbox Success Path is optional.  If the Dropbox Success Path is defined, the 

dropbox will move the original file placed in the dropbox to the success directory if and 

only if the corresponding e-mail or text is successfully delivered to the email server.  If 

the success path is empty, the dropbox will delete the original file placed in the dropbox 

if and only if the corresponding email or text is successfully delivered to the email server.  

If the dropbox fails to generate the e-mail or text, the file will be renamed with a time 

tagged ".droperror" extension and remain in the dropbox.  The dropbox will not attempt 

to generate an e-mail or text for a file with a ".droperror" extension in its filename.  

 

Recipient 

The Recipient identifies the designated recipient(s) for the e-mail or text.  The Recipient 

list will be populated with applicable recipients based on the Dropbox Type.  For 

example, if you select E-Mail or E-Mail File in the Type menu, the Recipient list will be 

populated with emails from the E-Mail List Tab and groups with at least one email 

address from the Group List Tab.  If you select Text in the Type menu, the Recipient list 

will be populated with cell phone numbers from the Cell List Tab and groups with at least 

one cell number from the Group List Tab. 

 

State 

The state controls whether the dropbox is activated.  It can be set to Off or On.  If the 

state is set to Off, the dropbox will not be activated.  If the state is set to On, the dropbox 

will be activated when you push the OK button.  If the state is set to On when you exit 

the application, it will automatically be activated the next time you run the application.  If 

you do not want the dropbox to be activated on application initialization, set the state to 

Off before exiting the application. 

 

 

Send E-Mail 

The Send E-Mail tab is shown in Figure 38.  This tab can be used to send an e-mail if 

valid information has been entered on the Global Settings tab.  Once the To, Subject, 

optional File (Browse can be used to browse the local disk for a file), and Message 
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information has been entered, press the Send button to send the e-mail.  This will initiate 

a request to send the e-mail.  Look at the main window message area for information 

about whether the e-mail request was successful or encountered any errors. 

 

 

Figure 38 Manage E-Mail and Text Settings Dialog (Send E-Mail Tab) 

 

 

Send Text 

The Send Text tab is shown in Figure 39.  This tab can be used to send a text if valid 

information has been entered on the Global Settings tab.  Once the To and Message 

information has been entered, press the Send button to send the text.  This will initiate a 

request to send the text.  Look at the main window message area for information about 

whether the text request was successful or encountered any errors. 
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Figure 39 Manage E-Mail and Text Settings Dialog (Send Text Tab) 

 

 

6.9 Advanced Settings Dialog 

The Advanced Settings dialog provides access to configure advanced settings.  This 

dialog is accessed from the Options menu.  The Advanced Settings dialog is shown in 

Figure 40. 

 

 

Figure 40 Advanced Settings Dialog 

 

Communication Timeout 
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You can set the timeout value used in communication with the Huntsville Operations 

Support Center.   It is unlikely there would ever be a need to modify this setting.  The 

timeout value can only be modified when the Command service is inactive.  

  

{else} 

Communication Timeout 

Unused in this release.   

 

 

Log TReK Command Interface Messages 

The TReK Command application provides the capability to log messages that are 

exchanged between the TReK Command application and the Destination to a file.  This 

capability has been provided for troubleshooting purposes.  Hopefully this is a feature 

you will never need to use.  If you check the Log TReK Command Interface Messages 

checkbox, the messages that are exchanged between the TReK Command application and 

the Destination will be written to the log file specified.  Message Logging will start when 

the Command service is activated and stop if you uncheck the box or the Command 

service is deactivated.  Once a log file exists, any new messages will be appended to the 

existing log file.  Log files are appended with the time the file was created as shown in 

the example below.  Log files older than 7 days are automatically deleted. 

 

Example Log File:  trek_command_interface_message_log_2021-03-14-18-26-49.txt 

   

Log Directory  

The Log Directory field should contain the absolute path to the directory where the log 

file should be written.  

   

Log Filename 

The Log Filename field should contain the name to use for the log file. 

 

6.10 POIC Connection Acknowledgement Dialog 

The POIC Connection Acknowledgement Dialog is shown in Figure 41.  This dialog 

displays information about the POIC Connection Acknowledgement.  The Decrease Font 

and Increase Font buttons decrease and increase the font.  The Fill Background checkbox 

will display color information by filling the background of the Value column. 

 



5.4.0 ISS  TREK-USER-0014 

 45 

 

Figure 41 POIC Connection Acknowledgement 

 

6.11 POIC Command System Configuration Dialog 

The POIC Command System Configuration Dialog is shown in Figure 42.  This dialog 

displays information about the POIC Command System Configuration.  The Decrease 

Font and Increase Font buttons decrease and increase the font.  The Fill Background 

checkbox will display color information by filling the background of the Value column. 
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Figure 42 POIC Command System Configuration 

 

6.12 POIC Command System Status Dialog 

The POIC Command System Status Dialog is shown in Figure 43.  This dialog displays 

information about the POIC Command System Status.  The Decrease Font and Increase 

Font buttons decrease and increase the font.  The Fill Background checkbox will display 

color information by filling the background of the Value column. 
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Figure 43 POIC Command System Status 

6.13 Application Messages 

Various types of application messages are generated including information, progress, 

warning, error, and debug messages.  Application messages are stored in memory and 

written to a temporary log file.  The temporary log file is created on application 

initialization and exists if the application is running.  It is deleted when you exit the 

application.  The log file is in the temporary directory provided by the operating system.  

Only a subset of messages is stored in memory while all messages are written to the 

temporary log file.  The maximum number of application messages stored in memory is 

controlled by the message storage setting in the Configure Messages dialog.  Once the 

maximum is reached, older messages are deleted to make room for new messages.  

Setting the maximum value to a large number can impact application performance since 

it will increase the amount of memory used by the application.  Setting this number too 

low can cause you to miss important messages.  The application default was selected to 

protect against both scenarios.  Messages stored in memory are displayed in the Main 

Window Message Area and the Messages dialog.  The Messages dialog is shown in 

Figure 44.  The Main Window message area only displays Info, Warning, and Error 

messages.  The Messages dialog displays messages based on the display preferences 

defined in the Configure Messages dialog.  By default, the Messages dialog will display 

information, progress, warning, and error messages.  Columns in the Messages dialog can 
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be sorted by clicking on the column header.  The Messages dialog is available from the 

Options menu.   

 

 

Figure 44 Messages Dialog 

 

Configure 

The Configure button provides access to the Configure Messages dialog shown in Figure 

45.  This dialog provides access to preferences associated with messages.  Display 

preferences can be set to filter the types of messages (category) displayed in the 

Messages dialog.  Export Preferences control how the time tag is added to the filename 

that is created when messages are exported.  See the Export section for details.  Message 

storage defines the maximum number of messages that will be stored in memory while 

the application is running.  Once the maximum is reached, older messages are deleted to 

make room for new messages.  The Set to Defaults button can be used to reset these 

properties to application defaults.   

 

 

 

Figure 45 Configure Messages Dialog 
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Clear 

The Clear button provides access to the Clear Messages dialog shown in Figure 46.  This 

dialog provides two ways to clear application messages stored in memory.  You can clear 

all the messages or clear selected messages.  Once you clear messages, the messages are 

permanently deleted in all views (Main Window Message Area and the Messages dialog).   

 

 

Figure 46 Clear Messages Dialog 

 

Export 

The Export button provides the capability to save all the application messages currently 

in memory to a file.  When you push the Export button you will be prompted for a 

directory and filename.  Export will save all messages in memory, not just the messages 

currently displayed in the Messages dialog (i.e., the Display Preferences are not applied).  

The name you provide for the file will be modified with a time tag that is added to the 

filename.  The time tag indicates the time the file was closed.  The default is to append 

the time tag to the filename.  For example: 

 

Filename Input:   messages.txt 

Filename Output: messages_2017-05-07_13~03~28.txt 

 

If you would like to prepend the time tag to the filename you can set this preference in 

the Configure Messages dialog.  This would result in the following: 

 

Filename Input:   messages.txt 

Filename Output: 2017-05-07_13~03~28_messages.txt 

 

 

Delog 

The Delog button provides the capability to save all application messages generated since 

the application was started.  Delog will retrieve the messages from the temporary log file.  

When you push the Delog button you will be prompted for a directory and filename.  A 

timetag is not applied to the filename. 

 

Filename Input:   messages.txt 

Filename Output: messages.txt 
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6.14 Application Configuration File 

The Command application saves the following information when you save a 

configuration:   

 

➢ Configuration information in the Configure Dialog. 

 

6.15 Application Settings 

The Command application saves some settings as application settings each time you exit 

the application.  The next time you run the application, the application will initialize with 

the previous application settings.  Only one set of settings are saved.  If you run multiple 

instances of the application, the settings in the instance that is exited last will be saved.  

The following application settings are saved: 

 

➢ Application Window Size 

➢ Command Preferences 

➢ Configure Messages Selections 

➢ E-Mail and Text Settings 

➢ Advanced Settings 

 

6.16 Application Command Line Arguments 

The Command application accepts the following command line arguments: 

 

➢ trek_command.exe <filename> 

 

filename to open a configuration file (full path to file) 

 

A value must be wrapped in double quotes if it contains spaces. 

 

Example: 

 

➢ trek_command.exe “D:/command config.xml” 

 

➢ trek_command.exe D:/command_config.xml 

 

 

If the configuration is valid, the application will automatically activate the command 

service. 

 

7 FAQ and Troubleshooting 

This section addresses Frequently Asked Questions and provides tips for troubleshooting 

common gotchas. 

 

No FAQs Yet. 
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